CRM WebUI User Experience Guide
## Contents

**CRM WebUI User Experience** ............................................................................................................ 1  
Access the CRM WebUI ......................................................................................................................... 1  
Web Browser Considerations ................................................................................................................ 2  
New Navigation .................................................................................................................................... 3  
**General Feature Enhancements** ........................................................................................................ 3  
  Explorer Bar ......................................................................................................................................... 4  
  Search .................................................................................................................................................. 4  
  Data Lists .......................................................................................................................................... 5  
**New Features for CRM WebUI** ........................................................................................................ 7  
  Batch and the WebUI User Experience .............................................................................................. 7  
    Batch Entry Toolbar .......................................................................................................................... 7  
  Key Performance Indicators (KPIs) ...................................................................................................... 8  
    KPI Terminology Changes ............................................................................................................... 8  
    KPI Changes .................................................................................................................................... 8  
  Marketing and Communications ......................................................................................................... 10  
    Convert Letters in the Letter Template Library and Letters Page .................................................. 10  
  Query and the WebUI User Experience ............................................................................................. 11  
    Ad-hoc Query ................................................................................................................................. 11  
    Smart Query .................................................................................................................................... 15  
    Query Results ................................................................................................................................. 17  
**What’s Different in CRM WebUI** .................................................................................................... 17
CRM WebUI User Experience

Access the CRM WebUI

Web Browser Considerations

New Navigation

General Feature Enhancements

New Features for CRM WebUI

What's Different in CRM WebUI

The 4.0 CRM release does not include support for the ClickOnce client. The replacement interface, WebUI, will be the sole interface in all future versions of CRM. WebUI was first introduced in CRM version 2.93, released in May of 2012. The WebUI version is a different user experience. As it is completely browser-based, most users find it familiar and easy to use; however some users may take some time to adapt. Some actions, such as drilling down into data lists, work differently in the WebUI version, but the patterns and functionality, once learned, are comparable if not better in the WebUI version. Blackbaud has taken care to make this a seamless transition; however there are a few known issues documented in this guide. We strive to keep this information as thorough, detailed, and accurate as possible. If you discover other features that are missing or work differently and those features are not documented here, please contact Support.

Show Me: Watch a short video highlighting the CRM WebUI user experience and basic navigation changes.

Access the CRM WebUI

With the 2.93 release, you can access the program through a web browser rather than through Microsoft Windows as in past releases. This WebUI user experience offers more flexibility in how you access the program, and provides new features and functionality, as well as enhancements to existing functionality. Before you start to work in the latest version, we recommend you familiarize yourself with these changes.

Note: We redesigned the program's Start page. The Blackbaud CRM button launches the WebUI version of the program in your browser. To access the ClickOnce version, click the Smart Client button.
Web Browser Considerations

The ability to access the program through a web browser offers more flexibility in how you access the program. Web browser settings and options, such as toolbar views and shortcut keys, can vary from browser to browser. To maximize the web-based user experience, we recommend you familiarize yourself with your web browser’s settings.

- Consider the number of toolbars you actively display in your browser. Numerous toolbars can decrease the area on your screen, which can require the need to scroll more. You can easily remove or hide toolbars as necessary.

- Review your browser’s shortcut keys. For example, you can use shortcut keys in your browser to navigate web pages or open Help. Because there are shortcut keys for data entry within the program, you need to be aware of any conflicts.

- Adjust the magnification, or “zoom”, level for your browser as necessary. For example, larger zoom levels decrease the area in which the program appears and can require you to scroll.

- To have the help file open as a new tab within the browser or as a new browser window that you can refer to as you, configure the browser setting that determines whether new windows open as new tabs.

- For optimal performance, access the program through a supported browser. For a list of supported browsers, see the system requirements.
New Navigation

The WebUI user experience offers new ways to access information within Blackbaud CRM. For example, header icons that used to appear as top-level page navigation now appear as tabs with easily accessible fly-out menus.

This top-level navigation also provides quick access to other common tasks and options.

Pervasive search

You can quickly search all features, such as to find specific tasks or functionality. You can also adjust the search to return only specific types of records, such as to quickly find a constituent or deposit.

Add new

To quickly add a new constituent or revenue record from anywhere in the program, click Add new and select the type of record to add, such as Individual or Payment.

Welcome menu

From the user name, you can access a menu to change your password, unlock optional modules, or run the program as another user. In the Windows-based user experience, you access these tasks through the Tools menu.

View calendar

To quickly access the organization calendar, such as to plan an event or communication, click View calendar.

Help menu

To quickly access the help file or view information about your version of the program, select About from the Help menu.

General Feature Enhancements

Throughout the WebUI user experience, you can now use enhancements to general features such as basic navigation, searches, and data lists.
Explorer Bar

On the explorer bar, you can now quickly access recently viewed information. Under **Recent searches**, you can access recently performed searches, complete with the criteria most recently used. Under **Recently accessed**, you can access recently view pages and records.

Several tasks that previously appeared on the explorer bar now appear elsewhere or not at all.

- The **Refresh** task that previously appeared on the explorer bar no longer appears in the web-based user experience. To refresh a page, simply refresh your browser.
- The **Help** task that previously appeared on the explorer bar now appears in the upper right-hand corner of your screen, next to **View calendar**. From the **Help** menu, you can now access the help.
- Tasks that previously appeared on the explorer bar of a functional area’s page, such as **Configuration** and **Reports**, now appear on the page itself.

In the Windows-based user experience, the explorer bar remained static when you scrolled through a page and displayed its own scroll bar as necessary. In the WebUI user experience, your browser’s scroll bars now control both the page and the explorer bar at the same time.

In the WebUI user experience, you can quickly expand or collapse the explorer bar as necessary. To expand or collapse the explorer bar, click **Show the explorer bar** or **Hide the explorer bar**, which appears as an arrow between the page and the explorer bar.

Search

To access or select an item from search results in the Windows-based user experience, you selected the item and clicked **Select**. In the WebUI user experience, search results now provide links to items directly from an item’s row. For example, to select a constituent or open a constituent’s record from a search, click the constituent’s row in the results.
On the explorer bar, you can access recently performed searches under **Recent searches**. When you access a recent search, it retains the criteria from the most recent search so you can quickly resume a previous search or adjust criteria as necessary.

**Data Lists**

In the WebUI user experience, data lists now provide several enhancements and differences from the **Windows-based user experience**.
Easy access to records

To access an item’s record from a data list in the Windows-based user experience, you selected the item and clicked **Go to**. In the WebUI user experience, the **Go to** action no longer appears. Data lists now include links to records directly from an item’s row. For example, to access a mailing’s record from a data list, click its name. Some data lists include links to multiple record types, such as to both a revenue record and the constituent associated with the transaction.

Right-click menu

From a data list in the WebUI user experience, you can access the same actions as the action bar through a right-click menu. From the right-click menu, you can also click **Export section** to download the data list to a comma-separated values (*.csv) file or Microsoft Excel (*.xlsx) spreadsheet.

Selection of multiple rows

With some data lists, you can now select and act upon multiple items at one time. These data lists include a column of checkboxes, from which you can select multiple items. From the header of the data list, you can easily select or deselect all checkboxes within the column.

Details view

From a data list in the Windows-based user experience, you could view additional information about an item from a **Details** window below the data list. In the WebUI user experience, a details view now appears directly beneath a selected row for the quick reference of additional information.

Multiple Data Lists on One Tab

If there are multiple data lists on one tab, the lists no longer appear in separate sections with individual vertical scroll bars for each section. Instead, they appear in a single section with a single vertical scroll bar, if needed.
New Features for CRM WebUI

The WebUI user experience offers new features, and enhancements to existing functionality, within the program.

Batch and the WebUI User Experience

The WebUI user experience offers new features, and changes to existing functionality, within Batch. We recommend you review these changes before working in Batch.

- To access a batch, simply double-click the batch in the grid, right-click and select Edit, or highlight and click Edit on the toolbar.
- If there is an exception chain, you now click the batch number which displays as a hyperlink.
- To view the batch commit parameters and status of your committed batches, you now select the Committed hyperlink in the Status column on the Committed Batches tab.
- The Details pane no longer appears at the bottom of the Batch Entry page when you select a batch. Now, the detail information expands directly underneath the batch you select.
- When working within a batch, cells with errors now display red “ticks” within the cell, so that you can easily identify them.
- A minimized batch data entry screen appears as a link at the bottom right of your browser. To maximize the screen, click the link.

Batch Entry Toolbar

As you enter information into a batch, you can use the toolbar ribbon to quickly find the commands that you need to complete a task. The tasks on the toolbar ribbon are unique to each batch type, and are grouped together under tabs. Each tab on the toolbar ribbon relates to a type of activity, such as Processes, Configuration, or Messages.
To quickly perform tasks on toolbar ribbon using your keyboard, select the Ctrl + M. Shortcut keys are then displayed over each feature that is available in the current view.

**Note:** If shortcut keys do not display, check your web browser’s pop-up blocker settings.

To access a task on the toolbar ribbon, select the corresponding letter. To exit the shortcut key display mode, you can select Esc, or simply click your mouse.

**Key Performance Indicators (KPIs)**

Key performance indicators (KPIs) track your organization’s strategic performance to help determine a course of action. The WebUI user experience offers enhancements that make setup easier and KPI information easier to interpret. Your existing KPIs still work correctly.

**KPI Terminology Changes**

“Yellow Until” and “Red until” terminology has been replaced with “Good Target” and “Satisfactory Target.” Actual numbers below the Satisfactory Target are considered “Poor Performance.” Actual numbers between the Satisfactory Target and the Good Target are considered “Satisfactory Performance.” Actual numbers above the “Good Target” are considered “Good Performance.”

**KPI Changes**

Adding a KPI is essentially the same as it was with in the Windows-based user experience, except for the Goal tab. With the new WebUI user experience, “sliders” on Goal tab graph have been removed, terminology has changed, and good target and satisfactory target numbers can be entered directly or as a percentage of the overall goal.
On the KPIs page, you can view “dashboard” information, including the KPI value chart, when you select a KPI instance listed in the grid. You can view and edit this KPI information from an open KPI instance as well.

You can now hover your mouse over the bullet graphs to display helpful tooltips for each element within the graph.

On the Goal Status tab of the record of a KPI, you can now quickly gauge the actual performance toward a goal and whether the value indicates poor, satisfactory, or good performance.
Marketing and Communications

With the WebUI user experience, you must convert all existing letters in the Letter Template Library and Letters page from a .doc file extension to a .docx file extension. This allows your documents to be compatible with printing and merging in the program. For more information, see Convert Letters in the Letter Template Library and Letters Page on page 10.

Convert Letters in the Letter Template Library and Letters Page

With the WebUI user experience, you must convert all existing letters in the Letter Template Library and Letters page, such as membership renewal letters, from a .doc file extension to a .docx file extension. This allows your letters to be compatible with printing and merging in the program.


- Convert letters from .doc to .docx

This procedure explains how to convert letters in the Letter Template Library, however, this procedure must also be performed on all letters on the Letters page in Marketing and Communications.

1. From Marketing and Communications, click Letter template library under Configuration. The Letter Template Library page appears.
2. Under Letter template, select the letter for which to convert, and click Edit. The Edit a letter template screen appears.
3. In the Letter field, click the link to the file for which to convert. The File Download screen appears.
4. Click Open. The file opens in Microsoft Word.
5. For Microsoft Word 2007 or 2010, click the Office Button, and select Save As. The Save As screen appears.
   For Microsoft Word 2003 or earlier, click File, and select Save As. The Save As screen appears.
6. In the Save as type field, select Word Document (*.docx).
7. For Microsoft Word 2007 or 2010, click Maintain compatibility with Word 97-2003 if the checkbox is not already selected.

Warning: This checkbox must be selected so the letter can be opened with versions earlier than Microsoft Word 2007.

8. Click Save.
9. In the program, on the Letter Template Library page, select the letter for which you just converted and click Edit. The Edit a letter template screen appears.
10. Click Choose file. The Choose File to Upload screen appears.
11. Browse to the location where you just saved the converted letter, and click Open. You return to the Edit a letter template screen and the converted file appears in the Letter field.
12. Click Save. You return to the Letter Template Library page, and the letter now contains the converted file.
Query and the WebUI User Experience

The WebUI user experience offers new features, and changes to existing functionality, within Query. We recommend you review these changes before working in Query.

**Ad-hoc Query**

When you select a source view to add an ad-hoc query, frequently used source views now appear under **Most commonly used** in the list. These source views are the ones most commonly used across the organization, not per user.

The New Ad-hoc Query screen and Edit Ad-hoc Query screen now feature several enhancements to help ease the creation and use of a query. These enhancements range from more instructive names for tabs and frames to completely new features. You can now also manage the query’s properties as you add or edit the query.

On the Select filter and output fields tab (previously the Output/Filters tab), you can browse to and select the output fields to include in the query results. To quickly find a field, you can now also search by its name in the **Find field** field. Under **Include records where**, you can apply filter criteria to fields. Under **Results fields to display**, you select the output fields to include in the results. You can continue to summarize amounts and dates by criteria such as SUM (total), MIN (smallest), or MAX (largest). To change how the name of a selected output field appears in the header of an export file, you can now click **Change column header** and enter the name to appear in an export.
On the Set sort and group options tab (previously the Sort/Group Filters tab), you select the fields to use to sort records in the results and how to order the results, such as ascending or descending. If you summarize output fields, under **Include records where**, you can apply filter criteria to those records. For example, if you select to view the sum of revenue transactions from constituents, a constituent appears one time rather than for each transaction.
On the Preview results tab (previously the Results tab), you can continue to preview the first 500 records of your query results. From this tab, you can also now select whether to display a column for the query ID of each record. You can also view the Structured Query Language (SQL) statement used to generate the query or download the preview to a comma-separated values (*.csv) file or XML spreadsheet (*.xlsx) file, such as for use in Microsoft Excel.
On the new Set save options tab, you can enter a unique name and description to help identify the query. You can also manage the properties of the query, such as whether to create a selection based on its results and which users can use and manage the query. Previously, you managed this information on a Query Properties screen.

![New Ad-hoc Query Window](Image)
Smart Query

When you add or edit an instance of a smart query, the Previews tab now includes new features. From this tab, you can now select whether to display a column for the query ID of each record. You can also download the preview to a *.csv file or XML spreadsheet (*.xlsx) file, such as for use in Microsoft Excel.
On the New Smart Query screen and Edit Smart Query screen, the Set save options tab now appears. On this tab, you can enter a unique name and description to help identify the query. You can also manage the properties of the query, such as whether to create a selection based on its results and which users can use and manage the query. Previously, you managed this information on a Query Properties screen.
Query Results

From a query’s results page, you can now download the results to a *.csv file or XML spreadsheet (*.xlsx) file, such as for use in Microsoft Excel. To download the results, click Export and select the file format to download.

Previously, you could only download and save the query results as a Microsoft Excel workbook (*.xls) file.

What's Different in CRM WebUI

Note: The WebUI version is a different user experience. As it is completely browser-based, most users find it familiar and easy to use; however some users may take some time to adapt. Some actions, such as drilling down into data lists, work differently in the WebUI version, but the patterns and functionality, once learned, are comparable if not better in the WebUI version. Blackbaud has taken care to make this a seamless transition; however there are a few known issues documented in this guide. We strive to keep this information as thorough, detailed, and accurate as possible. If you discover other features that are missing or work differently and those features are not documented here, please contact Support.

- Page designer is supported in 3.0 and higher WebUI versions. Users with administrative rights can now access Design Mode from the web-based user interface. Previously, Design Mode was only available through the ClickOnce version user interface. When an administrator opens Blackbaud CRM in a web browser, a new toggle button for Design Mode appears in the top right. To turn Design Mode on or off, simply click this button. Design Mode is not supported in the 2.93 and 2.94 versions of WebUI.

  In versions 2.93 and 2.94, changes made using page designer in ClickOnce are rendered in the web-based version. In these versions, Shell design in Administration is partially supported in WebUI. You can access the Shell design page and have access to some, but not all, of the tasks and actions. For example, you cannot use Shell design to set properties for things like functional areas, tasks, and pages. These features continue to work as they did before in the ClickOnce version for versions 2.93 and 2.94.

- The Catalog Browser, including the ability to load catalog items, is supported in the 2.94 and higher WebUI versions.
In the 2.93 version of WebUI, you can open and view items in the Catalog Browser. However, in order to load catalog items, you must use the ClickOnce version.

- Postal templates can be created in the 2.94 and higher WebUI versions.

In the 2.93 version of WebUI, postal templates cannot be created. Existing or new ones created in the ClickOnce version can be used in 2.93 WebUI, but not edited.

- In the 3.0 and higher WebUI versions, OLAP explorer and OLAP Excel reports are supported.

OLAP explorer and OLAP Excel reports are not supported in the 2.93 and 2.94 versions of WebUI. However, these features continue to work as they did before in the ClickOnce version of 2.93 and 2.94.

- Favorites from the ClickOnce version are supported as Shortcuts in the 3.0 and higher versions of WebUI.

In 2.93 and 2.94, favorites from the ClickOnce version are not supported in WebUI. However, in these versions, you can use your browser's favorites, shortcuts, or bookmark functionality. When you open the browser and click the browser favorite, you will be prompted to log in if you are not currently logged into the program.

- From a query definition in ClickOnce, you can click Create report. In the 3.0 and higher WebUI versions, this functionality is also available. You can also select a query on the main Query page and click Create, Report.

In versions 2.93 and 2.94 of WebUI, this functionality is only available on the main Query page when you select a query and click Create, Report. In these versions, you cannot create a report from the query definition.

- From a query definition in the 3.0 and higher WebUI versions, you can browse query results using a page definition. You can also run the query and, on the query page, click Browse and select a page definition. Or from the main Query page, you can select a query, click Browse, and select a page definition.

From a query definition in the 2.93 and 2.94 versions of WebUI, there is no browse results using a page definition. In these versions, if you run the query, on the query page you can click Browse and select a page definition. In the 2.94 version of WebUI, you can also select a query on the main Query page and click Browse.

- In the WebUI version for 2.93 and higher, communication processes will auto-merge *.docx files only, not *.doc; however, you can still download the output and merge the files outside of the program. Auto-merge works as it did before in the ClickOnce version.

- In the WebUI version for 2.93 and higher, the Write a letter task for a constituent does not allow you to open the letter directly in Word. After you save the Write a letter task, you are on the Interactions page for the constituent. The letter is saved on the Documentation tab as an attachment. You can select the letter and click Open file. Also, on the Write a letter screen, you must select an existing letter template; you cannot create a new one from the screen.

- In versions 2.93 and higher of the WebUI version, conditional mail merging within CRM is not supported. You can export data and perform conditional mail merges outside of CRM.

- In version 3.0 Service Pack 3 and higher, you can filter constituent interactions by Status. Prior to this version, you could not filter interactions by status in the WebUI version.

- In the ClickOnce version of the program, multi-level events had a hierarchy view so you could move quickly between the related events. In version 3.0 Service Pack 7 and higher, you also have this functionality in the WebUI version of the program.

- The Report model generator is supported in the 3.0 and higher WebUI versions. Reports created with the Report model generator in the ClickOnce version are available in Report explorer in the 3.0 and higher WebUI versions.
The Report model generator is not supported in the WebUI version for 2.93 and 2.94. Reports created with the Report model generator in the ClickOnce version are not available in Report explorer in the 2.93 and 2.94 WebUI versions.

- Not all browsers support all report functionality. In the WebUI version of CRM, certain browsers other than Microsoft's Internet Explorer do not support the ability to print reports. See this MSDN topic for more information.
- The KPI dashboard is not supported in the WebUI in versions 2.93 and 2.94. The KPI dashboard is supported in version 3.0 and higher.
- Basic revenue batches are not supported in the WebUI version beginning in 2.93.
  - In the 2.93 and 2.94 versions of WebUI, Revenue update batches are also not supported. However, these are supported in the WebUI version beginning in the 3.0 version.
- Blackbaud Internet Solutions transaction batches are not supported in the 2.93 and 2.94 versions of WebUI.
  - In the 3.0 and higher versions of WebUI, Blackbaud Internet Solutions Profile Update batches and Event Registration batches are supported. Donation batches are not supported, but you can instead use Enhanced Revenue batches for donation transactions. Signup batches are also not supported, but you can instead use Constituent Update batches for signup transactions.
- In the 2.93 and and 2.94 versions of WebUI, the ability to export from an open batch is not supported. However, this is supported in the WebUI version beginning in the 3.0 version.
- In the 2.93 and higher WebUI versions, the ability to freeze columns or use Find and Replace within a batch is not supported.
- In the 2.93 and higher WebUI versions, many of the shortcut keys for batch data entry have changed. Ctrl + M now calls up shortcut keys specific to the tasks available in an open batch. For detailed information, see Batch Entry Toolbar on page 7.
- The Enter membership dues batch is not supported in the 2.93 and higher ClickOnce versions of the program. It is supported in the 2.93 and higher WebUI versions only.
- The shift from the ClickOnce version to the WebUI version represents a "client-side" shift in rendering approaches, where the UI is rendered using pure HTML instead of Windows Forms technology. Therefore the UI component of any customization which uses Windows Forms technology will need to be re-implemented in order to render properly in the WebUI version. This requirement is only applicable for features which use the <FormUIComponent /> element to reference a Windows Forms component. Server-side components and features which use the default user interface (which is auto-generated at runtime) do not need to be rewritten.
- In the 4.0 version of WebUI, the option to select whether you access the program through the WebUI or ClickOnce is no longer available when you enable email alerts in Administration. If you previously selected the ClickOnce option, the program automatically uses the WebUI option instead.
- In the ClickOnce version of the program, you used the File menu to access the "save as" functionality for queries. In the 4.0 version of WebUI, a Save as option appears on the Ad-hoc Query screen.